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Programowanie układów 
FPGA w Altium Designer
Altium Innovation Station to zintegrowane środowisko składające się z oprogra-
mowania Altium Designer oraz płyty uruchomieniowej NanoBoard. Zapewnia ono 
komplet narzędzi i technologii potrzebnych do projektowania, implementowania, 
testowania i uruchamiania projektów FPGA. Co ważne, uruchamianie i testowanie 
odbywa się w czasie rzeczywistym.

wany, najstarszy bit wyjściowy jest dołączony do wejścia 
SLI, natomiast zanegowany najmłodszy bit wyjściowy 
jest doprowadzony do wejścia SRI. Zamiast budować taki 
licznik pierścieniowy z przerzutników D zastosujemy go-
towy komponent  rejestru przesuwnego SR8CLEDB. Bi-
blioteki takich i  podobnych komponentów są dostępne 
w pakiecie Altium Designer.

Sygnału zegarowy potrzebny do taktowania elemen-
tów logicznych jest generowany przez komponenty za-
montowane na płycie NanoBoard. Sygnały wyjściowe 
z licznika należy dołączyć do diod świecących LED.

Do sterowania działaniem licznika będącego przed-
miotem projektu niezbędne będą następujące sygnały 
wejściowe:

•	 KIERUNEK – poziom logiczny tego sygnału będzie 
określał kierunek przesuwania zawartości licznika: 
od lewej do prawej albo od prawej do lewej. Poziom 
ten będzie wymuszany przez przełącznika SW0 na 
płycie NanoBoard (część przełącznika DIP).

•	 STOP/START – poziom logiczny, który będzie zatrzy-
mywał lub uruchamiał zliczanie. Ten sygnał będzie 
zależny od ustawienie przełącznika SW2 na płycie 
NanoBoard (część przełącznika DIP).

•	 KASOWANIE – wyjścia licznika można wyzerować, 
co powoduje zgaszenie wszystkich diod LED, przez 
naciśnięcie klawisza DAUGHTER BD TEST/RESET 
zamontowanego na płycie NanoBoard.

Oprogramowanie narzędziowe
Zanim rozpoczniemy programowanie układów FPGA 
należy zainstalować odpowiednie narzędzia pochodzące 
od producentów układów programowalnych. Służą one 
do wykonania syntezy i implementacji dla  docelowego 
układu programowalnego. Narzędzia te nie są dostarcza-
ne wraz pakietem Altium Designer i powinny być pozy-
skane i zainstalowane niezależnie. Więcej informacji na 

Dzięki tej zunifikowanej technologii można zarzą-
dzać całym projektem wykonanym za pomocą Altium 
bez nadmiernego koncentrowania się na szczegółach, 
dzięki czemu można skoncentrować się na funkcjonal-
ności urządzenia – tworzonego produktu. Przed rozpo-
częciem tworzenia projektu urządzenia, tego oraz wielu 
innych budowanych w  przyszłości z  zastosowaniem 
układów mikroprocesorowych oraz oprogramowania 
wbudowanego, jest wskazane solidne zrozumienie pod-
staw projektowania w  tym innowacyjnym środowisku 
– implementowania podstawowych elementów logicz-
nych, a następnie testowania ich działania w rzeczywi-
stym środowisku, do czego może posłużyć płyta urucho-
mieniowa NanoBoard.

W  tym artykule przedstawiono implementację nie-
skomplikowanego układu logicznego zbudowanego 
z  podstawowych elementów logicznych, którymi są 
bramki, rejestry itp. (w kolejnych publikacjach będą opi-
sane bardziej zaawansowane projekty z wykorzystaniem 
mikroprocesorów softwareowych). W  przykładowym 
projekcie zaimplementowano licznik rewersyjny, który 
po zaprogramowaniu układu FPGA zamontowanego na 
płycie NanoBoard będzie kolejno (od lewej do prawej 
lub od prawej do lewej) zaświecał diody LED zamonto-
wane w zestawie. Nauczymy się korzystania ze zunifiko-
wanego środowiska Altium Designer, płyty NanoBoard, 
wskażemy metodologię projektowania układów FPGA ze 
szczególnym uwzględnieniem:

•	 Tworzenia projektu FPGA za pomocą środowiska Al-
tium Designer, a więc rysowanie schematu z zastoso-
waniem bibliotek elementów logicznych.

•	 Uruchomienie projektu na płycie NanoBoard przy 
użyciu funkcji automatycznej konfiguracji.

•	 Przetwarzania projektu – kompilowania, syntezy i im-
plementowania projektu, aby w  ich wyniku uzyskać 
pliki służące do zaprogramowania urządzenia docelo-
wego.

•	 Przykładowego projektu hie-
rarchicznego FPGA, włączając 
w  to przykład elementów lo-
gicznych utworzonych w  języ-
ku opisu sprzętu (HDL).

•	 Użycia narzędzi wspomagają-
cych programowanie.

Przykładowy projekt
Schemat licznika pierścieniowego 
pokazano na rysunku  1. Zanego- Rysunek 1. Licznik rewersyjny będący przedmiotem projektu
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Tabela 1.Eelementy potrzebne do naszego projektu
Nazwa 

elementu Symbol Opis Liczba 
elementów

FJKC
Przerzutnik J-K 
z  zerowaniem 
asynchronicznym

2

INV Negator 6

J8B_8S

Łącznik 
magistralowy 
– magistrala 
8-bitowa

1

OR2N2S

2-wejściowa 
bramka OR 
z  zanegowanymi 
wejściami (wersja 
z  pojedynczymi 
wejściami)

1

SR8CLED

8-bitowy szerego-
wo – równoległy 
rejestr przesuwny 
z  wejściem 
ustawiającym, 
maskowaniem ze-
gara i  zerowaniem 
asynchronicznym 
(wersja z  wyjściem 
magistralowym)

1

połączenie. Zanim będziemy mogli zająć się rysowaniem 
schematu, musimy utworzyć projekt. W kolejnych punk-
tach, krok po kroku, będą opisane kolejne czynności przy 
tworzeniu projektu licznika pierścieniowego.

Tworzenie nowego projektu FPGA
Podstawą każdego projektu stworzonego w  środo-

wisku Altium Designer jest plik projektu. Dla projektu 
FPGA musimy utworzyć nowy projekt FPGA. Zbiór pro-
jektu to plik o rozszerzeniu *.PrjFpg. Jest to zbiór ASCII, 
w którym zapisane są informacje o projekcie, takie jak: 
wykaz dokumentów należących do projektu, ustawienia 
parametrów wyjściowych, ustawienia dla kompilatora, 
sposoby kontroli błędów i inne. Aby utworzyć nowy pro-
jekt FPGA należy:

•	 Z menu programu wybrać File -> New -> Project -> 
FPGA Project.

•	 Klikając prawym klawiszem na nazwie domyślnej 
projektu (Prosty_licznik_rewersyjny.PrjFpg) w pane-
lu Projects należy zapisać plik projektu na dysku za 
pomocą polecenia Save Project.

	 Uwaga: W nazwach plików nie wolno używać znaku 
odstępu („  ”) i/lub myślnika („–”), ponieważ może to 
spowodować błędy podczas syntezy. W zamian po-
winien być stosowany znak podkreślenia („_”).
Dodawanie plików do projektu
Projekt FPGA jest projektem hierarchicznym. Może 

być do niego dołączona hierarchicznie dowolna liczba 
arkuszy schematów, modułów programów w  językach 
HDL, VHDL, Verilog lub dokumentów OpenBus. Ale 
należy pamiętać, że nadrzędny dokument projektu, tak 
zwany TOP LEVEL, powinien być arkuszem schematu. 
Arkusz ten zawiera nie tylko porty wejścia/wyjścia, to 
znaczy interfejs łączący wyprowadzenia fizycznego ukła-
du FPGA z portami projektu, ale również ułatwia integro-
wanie FPGA – PCB. W dalszej części artykułu pokażemy 
jak zbudować projekt hierarchiczny teraz będziemy pra-
cować na jednym arkuszu (TOP LEVEL):

Dodajmy nowy arkusz schematu klikając prawym 
klawiszem na nazwie projektu w  obszarze panelu Pro-
jects i wybieramy Add New to Project -> Schematic.

Zapisujemy dokument (File -> Save) w tym samym 
folderze, w którym znajduje się projekt, nadając mu na-
zwę licznik_rewersyjny.SchDoc.

Powyższe działanie jest modyfikacją projektu, więc 
jest konieczne również zapisanie całego projektu. Za-
pisujemy projekt za pomocą kliknięcia prawym przy-
ciskiem myszy na jego nazwie i wybierając opcję Save 
Project.

Rozmieszczenie elementów na 
schemacie

Na pustym arkuszu schematu należy rozmieścić ele-
menty oraz połączyć je, tak aby uzyskać zakładaną funk-
cjonalność gotowego urządzenia. Gotowe elementy bę-
dziemy pobierać z bibliotek środowiska Altium Designer.

W  tabeli 1 umieszczono wykaz elementów 
niezbędnych do zbudowania licznika pierścieniowe-
go. Wszystkie można pobrać z biblioteki FPGA Generic 
(FPGA Generic.IntLib) znajdującej się w folderze \Libra-
ry\Fpga.

W tabeli 2 umieszczono elementy interfejsu projek-
tu. Elementy te, powszechnie nazywane portami, łączą 
sygnały ze schematu TOP LEVEL z rzeczywistymi wy-
prowadzeniami I/O układu FPGA. Porty interfejsu znaj-

ten temat można znaleźć na następujących stronach pro-
ducentów podzespołów: 

•	 Actel Designer Libero IDE (www.actel.com). Oprogra-
mowanie wymaga licencji. Warunki licencjonowania 
oraz dostępne rodzaje licencji można znaleźć na stro-
nie internetowej.

•	 Altera Quartus II (www.altera.com). Oprogramowa-
nie Altera Quartus II Web Edition jest udostępniane 
za darmo.

•	 Lattice Diamond oraz ispLever (www.latticesemi.com). 
Programy Diamond oraz ispLever Starter wymagają li-
cencji. Warunki licencjonowania oraz dostępne rodza-
je licencji można znaleźć na stronie internetowej.

•	 Xilinx ISE (www.xilinx.com). Program ISE WebPACK 
jest udostępniany za darmo.
Ogólna zasada jest taka, że najnowsza wersja Altium 

Designera wspiera najnowsze oprogramowanie narzę-
dziowe firm Xilinx i Altera.

Przykładowy projekt
Pierwszą rzeczą, którą należy zrobić to przeniesienie 
koncepcję projektu do środowiska Altium Designer. Dla 
tego projektu będzie to oznaczało rozmieszczenie nie-
zbędnych elementów na schemacie i  odpowiednie ich 

Rysunek 2. Nowy projekt FPGA z pojedynczym arku-
szem schematu
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REKLAMA

opcję Bar. Symbol GND trzeba połączyć z wejściem 
CLR rejestru D.

•	 Kolejny symbol GND połączyć z wejściem CLR re-
jestru przesuwnego jak pokazano na rysunku 4.

•	 Z paska narzędziowego Wiring należy wybrać ikonę 
z symbolem magistrali GND (rysunek 5). Podobnie 
jak poprzednio, należy zmienić Style na Bar. Nastę-
pnie wstawić ten symbol na schemacie dołączając 
go do wejść D[7..0] rejestru przesuwnego (rysunek 
6).

•	 Kolejnym krokiem jest dodanie dwóch indywidu-
alnych wyjść magistralowych z magistrali dołączo-
nej do wyjścia rejestru przesuwnego (rysunku 7). 
Te wyjścia są potrzebne do wykonania sprzężenia 
zwrotnego. Sygnały po zanegowaniu zostaną dołą-
czone do wejść SLI oraz SRI rejestru przesuwnego.

•	 W  celu uporządkowania projektu i  zmniejsze-
nia liczby ostrzeżeń można umieścić na arkuszu 
schematu dyrektywy No ERC na każdym niepołą-

Rysunek 3. Wstępne rozmieszczenie elementów na arkuszu schematu

dują się w bibliotece użytej płyty, w naszym 
wypadku FPGA NB3000 (FPGA NB3000 Port-
-Plugin.IntLib) w folderze \Library\Fpga. 

Na arkuszu schematu należy rozmieścić 
elementy, jak na rysunku 3. Elementy znaj-
dują się w bibliotekach, które są instalowa-
ne domyślnie z  pakietem Altium Designer. 
Biblioteki są dostępne za pomocą panela 
Libraries. Z  jego użyciem należy otworzyć 
odpowiednią bibliotekę, wskazać element 
i  umieścić go na schemacie klikając przy-
cisk Place. Za pomocą klawisza spacji można elementy 
obracać w zależności od potrzeb. Klawisz X umożliwia 
odbicie lustrzane.

Po rozmieszczeniu elementów na arkuszu należy 
je ponumerować. Najszybciej to można zrobić wybie-
rając z menu polecenie Tools -> Annotate Schematics 
Quietly.

Połączenia
Elementy znajdujące się na arkuszu schematu na-

leży w odpowiedni sposób połączyć.
•	 Aby połączyć elementy, należy kliknąć prawym 

klawiszem myszy na arkuszu schematy i  z  menu 
kontekstowego wybrać Place -> Wire lub  Place -> 
Bus. Sposób wykonania połączeń zilustrowano na 
rysunku 1.

•	 Z paska narzędziowego należy wybrać ikonę GND 
i umieścić symbol GND na schemacie. Zanim sym-
bol zostanie umieszczony na schemacie można go 
edytować naciskając klawisz Tab. W  oknie dialo-
gowym należy zmienić m. in. Style wybierając np. 
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Rysunek 4. Przerzutnik - połączenie GND

Rysunek 5. Ikona – sym-
bol GND

Rysunek 6. Rejestr prze-
suwny – połączenie GND

Rysunek 7. Dodanie wyjść 
magistralowych

Rysunek 8. Dyrektywy No ERC

Rysunek 9. Kompletny 
projekt – ze wszystki-
mi etykietami i połą-
czeniami

Dzięki temu projekt 
będzie łatwiejszy do 
zrozumienia i  do uru-
chomienia. Aby dodać 
etykiety jak na rysunku 
9, należy użyć poleceń 
Place -> Net Label. Na 
zakończenie, przed wy-
konaniem syntezy, nale-
ży zapisać projekt korzy-
stając z  poleceń File -> 
Save All.

W kolejnej części po-
każemy jak sposób przeprowadzenia syntezy, zaprogra-
mowania płyty docelowej NanoBoard oraz uruchomienia 
nowoutworzonego programu.

Wojciech Pietrasina
Evatronix SA

Dodatkowe informacje:
Evatronix S.A., ul. W. Przybyły 2, 43-300 Bielsko-Biała
tel. 33-499-59-12, faks: 33-499-59-18
e-mail: eda@evatronix.com, www.evatronix.com

Tabela 2. Porty potrzebne do naszego projektu.
Symbol Nazwa Opis

CLOCK_REFERENCE

CLK_REF sygnał zegara systemowego płyty NanoBoard 
o  stałej częstotliwości 20 MHz. W  projekcie będzie on 
używany jako sygnał zegarowy taktujący rejestr przesuwny 
oraz przerzutniki D do synchronizacji układów logicznych 
zerowania.

DIPSWITCH

Komponent przełącznika DIP-switch umieszczony na 
płycie NanoBoard. Będą używane tylko trzy bity z  tego 
przełącznika do ustawienia kierunku (lewo/prawo) oraz do 
zatrzymania zliczania.

LED

Komponent diod świecących LED zamontowanych na płycie 
NanoBoard. Diody LED będą używane do wizualizacji 
poziomów występujących na wyjściach licznika pierścienio-
wego.

TEST_BUTTON

Przycisk znajdujący się na płycie NanoBoard DAUGHTER 
BD TEST/RESET. Zanegowany sygnał przycisku będzie 
używany do wygenerowania sygnału Load Enable rejestru 
przesuwnego ładującego wartość domyślną. Wejścia D 
tego rejestru są dołączone do masy (GND), co powoduje, 
że ładowaną wartością  domyślną jest wektor o  wartości 
zero.

czonym wyjściu rozcięcia 
magistralowego (U15). 
Z  belki narzędziowej Wi-
ring wybieramy ikonę No 

ERC i  kładziemy ją na schemacie. Dyrektywę No 
ERC należy umieścić na każdym nieużywanym 
wyjściu O3…O7, jak to pokazano na rysunku 8.
Aby zakończyć projekt, musimy jeszcze dodać ety-

kiety magistrali do naszego obwodu.

http://sklep.avt.pl


